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Abstract 
 
 

The Kibra gene is located on human chromosome 5 at location: 5q34-q35.2. It produces a 

1,113 amino acid long protein that has a molecular mass of about 125 kilodaltons. This 

phosphoprotein contains two N-terminal, conserved tryptophan domains (i.e., WW) 

around 40 amino acids long and a glutamic acid rich stretch in its C-terminal half. It is a 

protein found to be expressed in breast cancer cells and memory related brain structures 

such as the hippocampus and temporal lobes.  

 

It has long been known that the non-protein coding regions of DNA are involved in the 

transcriptional control of a specific gene. These non-protein coding regions of DNA that 

either increase or decrease the expression levels of a certain gene are also known 

commonly as ‘Locus Control Regions’. The objective of this research project is to 

identify such functional, non-coding elements that regulate the transcription of the Kibra 

gene.  

 

These non-coding elements are often sites in the genome that are sensitive to the enzyme 

DNase-I. The project aims to precisely localize such cis-regulatory sequences and other 

functional modalities encoded by these DNase-I Hypersensitive sites (traditionally 

localized using Southern blot) through the use of the quantitative polymerase chain 

reaction approach in cancer cell lines.  
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Introduction 
 

 

The Kibra gene is located on human chromosome 5 at location: 5q34-q35.2. It produces a 

1,113 amino acid long protein that has a molecular mass of about 125 kilodaltons. This 

phosphoprotein contains two N-terminal, conserved tryptophan domains (i.e., WW) 

around 40 amino acids long and a glutamic acid rich stretch in its C-terminal half. [31] 

WW motif containing proteins are known to mediate protein-protein interactions which 

are essential for the transmission of cellular signals. The Kibra is of interest because it is 

seen to be highly expressed in the brain and might therefore play a role in specific 

cognitive pathways. 

  

It is a protein found to be expressed in breast cancer cells in relation to it’s interaction 

with the Dynein Light Chain 1(DLC1) [33] protein leading to growth stimulation in the 

same. It is also found to be expressed in its truncated form, where it’s missing the first 

223 amino acids in memory retrieval related brain structures such as the hippocampus 

and temporal lobes, and functional magnetic resonance imaging (fMRI) studies show a 

significant role of Kibra in memory performance. [32]  

 

The genetic material in humans is packaged in the form of chromatin within the nucleus. 

It is basically a tightly wound complex of DNA and histone proteins. The expression of 

various genes in different tissues at specific time points in the cell cycle is dependent 

upon which sections of chromatin are condensed (heterochromatin) or open 

(euchromatin) during that specific cellular phase. Genes in the euchromatin are exposed 

to transcriptional mechanism and this is seen mainly of most of the active genes. Genes in 

the heterochromatin do not get expressed as they are not exposed to the cells 

transcriptional machinery. Thus gene expression is tightly associated with the structure of 

the chromatin in that region. 

 

How and why then, this folding and unfolding of chromatin occurs and is timed within a 

cell cycle is not yet fully understood. There are several theories [20] based on experimental 
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data to explain how and why chromatin structure unfolds, which suggest various 

techniques like remodeling complexes causing histone modifications (acetylation, 

methylation or phosphorylation of histone amino acids) to epigenetic inheritance leading 

to maintenance of gene expression patterns throughout generations. 

    

It has long been known that the non-protein coding regions of DNA are involved in the 

transcriptional control of genes, as they are often capable of binding proteins that 

modulate transcription. These non-protein coding regions of DNA that either increase 

(enhancer or promoters) or decrease (repressors) the expression levels of a certain gene 

are also known commonly as ‘Locus Control Regions’ [9,10,17,19,26]. One of the most well 

studied Locus Control regions is the human HBB (β-globin) LCR [1]. The objective of 

this research project is to identify functional, non-coding elements that are involved in the 

regulation of the Kibra gene so as to understand its possible contribution in a disease 

process like memory loss or performance.  

 

Non-coding elements are often sites in the genome that are sensitive to the enzyme 

DNase-I, which attacks unprotected or unbound (to any proteins) DNA. These nuclease 

hypersensitive sites are said to lack the presence of a nucleosome, thereby, making them 

accessible and almost two-fold more sensitive to DNase-I activity [26] than the other 

regions of chromatin. An advantage of using DNase-I for detecting these sites is its 

relatively low sequence specificity. The main types of DNase-I hypersensitive sites are: 

constitutive, inducible, tissue specific and developmental [26]. The constitutive and 

inducible sites are often found upstream of the promoter region of a gene. 

 

The project aims to locate such cis-regulatory sequences and other functional modalities 

corresponding to these DNase-I Hypersensitive sites (traditionally localized using 

Southern blot) through the use of the quantitative polymerase chain reaction approach 

using four cell lines. The cell lines used will be T-47D (breast cancer), U-87 MG 

(Glioblastoma, brain) and the MDA-MB-436 (breast tissue). One of these cell lines, 

IMR-90, is a normal lung fibroblast and along with the U-87 MG cell line is a low 

expresser of Kibra. The T-47D and MDA-MB-436 cell lines are high expressers of Kibra.  
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We expect different hypersensitivity profiles between the high-expresser and low-

expresser cell lines. 
 

The 2 -∆∆ Ct  method [1, 4, 5]

 
The polymerase chain reaction can be performed either qualitatively or quantitatively. 

Two approaches for quantitative PCR include absolute quantification and relative 

quantification. In absolute quantification, the exact copy number of the PCR product is 

estimated using a standard curve. We used the relative quantification approach as we 

needed to compare the PCR amplification signal obtained from a DNase-I treated group 

of genomic DNA fragments versus, an untreated group spanning the genomic region of 

the Kibra gene. 

 

The methodology used to analyze functional, non-coding, regulatory genetic elements is 

the 2 -∆∆Ct method [4, 5] which allows monitoring of the digestion of DNA fragments by 

DNase-I as it allows an easy comparison between the Cycle threshold values of the 

DNase-I treated versus those of the untreated fragments of genomic DNA. We would be 

using the quantitative polymerase chain reaction (QT-PCR) for this experiment and 

calculating the results from the QT-PCR experiment through the 2 -∆∆ Ct method to obtain 

information on the Kibra gene locus. 

 

In this method the cell lines will be harvested at 70% growth confluence levels and their 

nuclei will be isolated. Half will be treated with varying concentrations from 10-80 U/ml 

of DNase-I enzyme and the other half will not be treated with DNase-I. The purified 

DNA from such extracts will be subjected to quantitative polymerase chain reaction using 

SYBR green and an ABI 7900 instrument.  

 

 

 

 

 8



Figure 1: General outline of the Protocol (Dorschner et. al. 2004) [1]

 

 
 

Thirty primer pairs approximately 250 bp in length ± 50 bases were designed across the 

Kibra gene region for the qPCR experiments.  Individual primers have a temperature of 

melting (Tm) between 60°C ± 2°C using the program Primer3. 

 

We are in the process of conducting a preliminary experiment to test DNase-I 

hypersensitivity in known hypersensitive regions using two PCR amplicons designed for 

the same so as to arrive at a single concentration of DNase-I to be used for the entire 

experiment. These assays would then be used throughout the project as positive controls. 

Output from the quantitative PCR reaction includes Ct (cycle threshold) values and PCR 

efficiencies of each individual amplicon.  
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The Plate setup for the final PCR Reaction would be as follows:  

 

(10-80 U/ml) DNase –I treated and untreated, 2 primers spanning known hypersensitive 

regions (eight replicates each). 

 

(10-80 U/ml) DNase – I treated and untreated RHO primer (eight replicates each) 

  

A detailed Excel worksheet containing the plate layout has been attached in Appendix-II 

of this report. 

 

For absolute quantification in a typical quantitative polymerase chain reaction one needs 

to perform a standard curve experiment to validate the efficiency of a test reaction and 

the internal reference gene amplicon. Since this would be a relative comparison and not 

an absolute one, we would only be running a standard curve using the reference gene 

reaction as an internal control measure on every PCR reaction plate to verify the accuracy 

of the results. The reference gene reaction is RHO (Rhodopsin gene). Rhodopsin is 

present on Chromosome 3 of the human genome and is DNase-I insensitive and 

therefore, it is selected as the reference gene. 

 

We would then measure the DNase-I sensitivity ratios of individual reactions versus their 

genomic location within the Kibra sequence and determine the moving baseline and 95% 

confidence bounds using R coding. We then identify the low-variance outliers and 

compute the signal to noise ratio for each outlier versus their genomic position within 

Kibra. These local maxima identified would be the putative locus control regions we are 

seeking. 

 

Once we arrive at a DNase-I concentration that shows the presence of DNase-I 

hypersensitive sites within these 2 primers, we could later use this same concentration for 

the microarray approach to detect hypersensitive sites in the different cell lines. 
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Methods and Discussion 
 

The following are phases which we need to complete, to obtain relevant data through 

preliminary data analysis: [1]

 

1.) Obtaining cycle threshold (Ct) data for all replicates of the 2 test primers designed 

across previously known hypersensitive regions along with the Rhodopsin primer 

internal control Ct values. 

       

      Figure 2: Amplification Plot as seen in ABI Prism 7900 SDS software 

 
 

2.) Amplification efficiency correction is done using the following criteria [5]: 

(personal communication, Dr. Jan Ruijter) 

a. The efficiency values must be within the median range of efficiency 

values ± 0.05 

b. The range of R values is between 0.995 to 0.999 and, 

c. The range of efficiency values is between 1.8 and 2.0 
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3.) The melting curve analysis was done using the ABI Prism 7900 SDS software, so 

as to ensure that every amplicon showed a single product curve. Quality control 

for each amplicon has also been completed by running them on a polymerase gel 

to see that every primer pair gives only a single band i.e. a single PCR product. 

 

Figure 3: Quality Control for Primer rows A-D 

 
 

Figure 4: Quality Control for Primer rows E-G 
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Figure 5: Dissociation Curve as seen in ABI Prism 7900 SDS software 

 
 

In the above picture all the PCR amplicons were selected in the software interface, 

which is why multiple melting point curves are seen. Upon selecting individual PCR 

amplicons we can clearly see that each amplicon produces only a single product 

thereby adding information to the already existing gel electrophoresis image quality 

control data, stating the same. 

 

4.) The calculation of DNase I sensitivity ratios is explained later in this discussion 

along with formulae. 

 

The primary data analysis may be broken down into the following sub-phases: [1]

(Status: Test run with known DNase-I hypersensitive region primers (2) in progress and 

results from the first run are provided in the results section below.) 

1.) Normalized fluorescence data were obtained using the ABI Prism 7900 SDS 

software and exported into Microsoft Excel worksheet for further analysis. The 

procedure for exporting this data is also mentioned below.  
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2.) An amplification curve and nth-order polynomial fit was obtained for each 

amplicon through the use of the ABI Prism 7900 SDS software.  

 

3.) The Ct (cycle threshold) values were then extracted for each curve through the 

ABI Prism 7900 SDS software and exported into Microsoft Excel worksheet for 

further analysis.  

 

4.) The amplification efficiency of the reference RHO (Rhodopsin) amplicon was 

obtained for every reaction plate using 5 replicates each of a standard dilution 

series of DNA amounts in the range: 0.3 ng, 3 ng, 30 ng, and 300 ng.   

 

5.) We extract the ‘clipped’ data from the “delta Rn Vs. Cycle number” graph from 

the ABI 7900 HT SDS – Sequence Detection Systems software version 2.3 

through the following procedure and then import it into the LinRegPCR[5] 

software: 

 

1.) Start the SDS 2.3 Software program. 

2.) Click on File -> Open and then select the SDS data file to process. 

3.) Click on the Analysis tab and click on Analyze. 

4.) To export data to *.xls format : 

a. Select the wells to export data from or you could export data from the 

entire plate. 

b. Click on File -> Export, an Export window will open up. 

c. In the Export drop down menu select data type “Clipped” 

d. Select radio button option in the From: section to either “All Wells” or 

“Selected Wells”. 

e. Give a suitable file name and save the file in the Tab-delimited Text 

format *.txt 

f. Click on the Export button. 

g. Navigate to the saved *.txt file and open it. 

h. In the opened text file click on Edit -> Select All, Copy. 
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i. Open Excel and Paste the data. The Excel file will now contain Rn values 

per amplification cycle and Delta Rn values per cycle for every amplicon. 

j. Select only the Delta Rn values and paste them in a new excel worksheet, 

save the excel worksheet as a *.xls file and then open the LinRegPCR 

software. 

k. The excel file thus obtained can be exported into the LinRegPCR software 

and looks exactly like the snapshot taken shown below in Figure 6. 
Figure 6: Snapshot of clipped data from delta Rn vs. cycle number graph
 

 
 

5.) Reading Data into LinRegPCR software: 

Once the data is exported into excel, do not close excel, open the LinRegPCR 

software and select the name of the excel worksheet from which data is to be 

imported in the Book: section of the first page of the software. Then specify the 

columns and rows to be imported from the excel worksheet and choose data file 

format as Applied Biosystems. 
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Figure 7: Export data from excel into LinRegPCR software 

 
 
6.) Once the data is imported into LinRegPCR, this is how the ‘All Sample View 

Screen’ will look. This graph displays the data points of all imported samples. 

With the arrow keys you can browse through the samples. The ‘Log Axis’ check 

box at the top left hand corner of the graph toggles between the logarithmic and 

normal Y-axis. 
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      Figure 8: ‘All Sample View Screen’ in LinRegPCR software 

       
 

7.) Then click on the third tab: ‘Fit Options’ and select the default fit options and 

click on the ‘Fit All’ option which allows for automatically fitting all data points 

on every single curve according to the following criteria: 

 

a. The iterative algorithm of the software selects for at least 4 and maximum 

6 data points 

b. with the highest R2 value (note, R2 value cannot be seen in this software 

during data analysis and this is done so as to not allow unfair manipulation 

of data.) 

c. And a slope, close to the maximum slope. 

 

After automatic fitting of data one must look through every single curve to see if 

the 4 to 6 data points selected on every curve are within the linear portion of the 

curve and not the plateau phase of the S shaped amplification plot. 

 

Here, 
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Intercept = Log (No)   

i.e. No = 10intercept

[where No is the initial input amount of material.] 

 

Slope = Log (E)   

i.e. E = 10slope 

[where, E is the efficiency value of that sample at that given cycle threshold (Ct).] 

 

8.) We derived the efficiency of each test amplicon from the amplification curve 

using the LinRegPCR software. 

Figure 9: Selecting Data Points for each individual curve in LinRegPCR 

 
 

9.) When all the adjustments to the data are complete, Choose File -> Save to Excel 

from the menu and choose the name of the excel workbook and worksheet to save 

your results into. The following picture shows how the final results sheet looks 

like. Following a three line header, one finds eight columns with sample number, 

sample name, lower and upper limit of window-of-linearity, number of included 
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points from that specific curve, starting concentration of the material No, PCR 

efficiency and correlation coefficient R squared. 

 

a. The output of the program gives the No values in fluorescence units the 

same as the output of the quantitative PCR machine is. To be able to 

convert to copy number or ng amount, we need a calibration curve. In our 

experiment though, we would be normalizing our results and giving them 

in the form of a ratio relative to the reference gene Rhodopsin and the 

DNase-I untreated samples, therefore we did not need a calibration curve 

as such ratios do not have a unit. 
 

Figure 10: Final results output sheet with PCR efficiencies from LinRegPCR 
             

 
 

10.) The general guidelines for selecting good data points from this final excel 

worksheet so as to perform efficiency correction on data points from all 

amplicons, are as follows: (personal communication, Dr. Jan Ruijter) [5]  

 

a. Samples with strongly deviating PCR efficiencies have to be considered 

unreliable and re-run if adequate data points aren’t obtained from a given 
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PCR plate. The PCR efficiency variation permissible per amplicon should 

be within the median efficiency for that amplicon’s range of efficiency 

values plus or minus 0.05. 

 

b. As per the author’s [5] suggestion, samples with correlation coefficients 

below R=0.999 have to be considered suspicious because the points that 

are used to determine the efficiency (E) from must be on a very straight 

line. The difference between a line with R=0.999 and R=0.995 is not 

visible on most computer screens because the line is drawn in pixels. So 

one can only trust the R value, not what one sees. However, I have not 

used this criterion too strictly as we have found no supporting data 

requiring implementation of this stringent criterion. 

 

11.) We then calculate the copy number differences arising due to DNase-I 

digestion, using the comparative Ct method using the expression given below.  

 

12.) Efficiency corrected Ct values would then be used to compute a relative 

copy number ratio by applying the formula 2 – ΔΔCt [4]  OR  

2 –[ DNase-I treated (target – reference RHO) –  untreated (target – reference RHO) ].  

 

Relative DNase-I sensitivity ratios thus obtained, having a value of less than one, would 

be indicative of relative copy loss resulting from digestion of that specific region by 

DNase-I. 

 

The 2 – ΔΔCt method formula used in calculations is as follows [6,7,8,12]: 
XN,q = XT  =  X0 x (EX)CT,X    =  DNase-I treated target  

             RT      R0 x (ER)CT,R                 RHO treated 

          

        = Efficiency of primer A [(10-80) DNase I conc] Ct A (10-80)

           Efficiency of RHO [(10-80) DNase I conc] Ct RHO (10-80)
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        = Normalized Target (Test) 

 

Similarly, XN,Cb = Untreated target  = Efficiency of primerA (0 DNase I conc) Ct A (0)  

                                 Untreated RHO    Efficiency of RHO (0 DNase I conc) Ct RHO (0)

                    

                 = Normalized Target (Calibrator) 

 

And,  XN,q   = Normalized Target (Test)    =     2 – ΔΔCt 

  XN,Cb    Normalized Target (Calibrator) 

 

Where, 

XT = Number of Target Molecules at cycle threshold CT,X 

RT = Number of Reference Molecules at cycle threshold CT,R 

XN, q = Ratio of DNase-I treated 

XN, Cb = Ratio of DNase-I untreated (calibrator) 

X0 = Initial Number of Target molecules 

R0 = Initial Number of Reference molecules 

EX = Efficiency of Target at CT, X 

ER = Efficiency of Reference at CT,R 

 

Note: All the Ct values used in the formulae above are statistically corrected Ct values 

 

The real-time PCR efficiency value should be close to 2.0 because at every stage in the 

linear part of the curve the amount of material (PCR product) is exactly doubled. 

 

Since, the initial number of molecules i.e. amount is 30 ng/uL, the X0 and R0 can be 

eliminated from the above equation. And, the high expression cell lines for Kibra can be 

compared with the low expresser cell lines. 
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Results 
 
Two amplicons A and B were designed across known DNase-I hypersensitive sites, 

which could be used as positive controls during the experiment. The data currently 

available is for the high expresser cell line MDA-MB-436 (details of which are given in 

the Appendix). We tested primer A within this cell line so as arrive at a single specific 

concentration of DNase-I that would help detect a hypersensitive site. We have the 

following number of good data points after statistical corrections to the data: (The results 

for the same are included in tabular form in Appendix-III) 

 
DNase-I Conc. No. of Good Data Points 

0 4 

10 4 

20 4 

30 4 

40 3 

50 3 

60 4 

70 4 

80 3 

  

Rho 0 3 

Rho 10 2 

Rho 20 1 

 

When we did 8 replicates on a 386 well plate, we got (3-4) good data points from the 

experiment. So when doing the next experiment, we would need to start with doing 8 

replicates to get at least 3-4 good replicate data points. The layout for the 386 well plate 

has been provided in Appendix-II of this report. 

 

After statistical corrections and eliminating data points whose R values were not close to 

0.995 and above and whose efficiency values were not close to 1.8-2.0 range, the graph 

looks as follows: 
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Statically corrected Ct values Vs DNase I conc
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When we take an average of these good data point values the graph we get is as follows: 
 

Avg Ct Vs DNase I conc

20
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0 10 20 30 40 50 60 70 80 90
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Linear (Series1)

 
 

As can be seen from this graph above, there is a drop in the Ct values at DNase-I 

concentration of 40 U/ml. We will continue to extract more data points at this sensitive 

concentration so as to verify this result and also test the 2nd positive control amplicon B 

(known hypersensitive region).  
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If the same results show up on amplicon B, we could use this specific DNase-I 

concentration to test the remaining 30 amplicons designed across chr5:167,769,118-

167,801,709 in the Kibra gene so as to elucidate the locus control regions present. 
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Future Work – Recommendations 
 

We continue to use the quantitative PCR method to elucidate the complete DNase-I 

hypersensitive profile at the Kibra gene locus, but doing so in multiple cell lines from 

different tissue samples is cumbersome. Testing in multiple cancer cell lines would get 

easier using a microarray approach. In fact up to eight different cells lines may be tested 

on a single microarray slide with replicates. 

 

The following is a short comparison between the quantitative PCR approach using 

the 2-∆∆Ct method and the microarray technology: [1, 2]

 

The main difference in both methodologies in terms of experimental setup is that the QT-

PCR technology uses DNase-I treated versus non-treated cells and signal to noise ratios, 

whereas the microarray methodology would use the ratio between DNase-I treated nuclei 

-> extracted DNA (chromatin specific fragments) versus DNase-I treated naked genomic 

DNA fragments.  

 

The cells would need to be synchronized in the G1 phase for the microarray 

methodology, whereas for QT-PCR via the 2-∆∆Ct method, the cells are not synchronized. 

The reason why it would be a good idea to synchronize the cell growth phase would be 

because the exposure of some non-coding functional elements on the chromosome would 

be different in different cell growth phases i.e. as compared from G1 to M phase.  

 

There is evidence that the microarray method allows for a great deal of reproducibility [2] 

i.e. if you repeat the same experiment even with a different batch of cultured cells the 

difference between the information collected out of the two experiments was shown to be 

about 6%. The accuracy of both methods is commendable when compared against 

previously existing Southern blot data as verified by experiments in referenced articles 1 

and 2.  

 

There are no southern blot experiments done on the Kibra that give information about 
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where the DNase-I hypersensitive sites might be within the 32.4 kb region and therefore 

placing positive controls on the microarray slides would be essential. These would 

mainly be known DNase-I hypersensitive regions which have been previously explored 

through other genetic experiments. A list of some of these positive control LCR’s is also 

provided in Appendix-IV of this report. 

 

The computational part for the microarray experiment would be far more intense as 

compared to the QT-PCR method as we would need to analyze patterns in consecutive 

microarray spots along with differences in color intensities so as to ascertain presence of 

hypersensitive regions. We would use the Axon GenePix Pro program to extract the 

signal intensities from the microarray scanned images. For the secondary data analysis, 

we would use R code.  

 

One of the few common advantages of using the microarray method is that it provides 

more data through increased replicates. Experimental and personal error like handling 

etc. is also reduced in the microarray method, because the total number of steps involved 

in the bench-work for a microarray experiment is far less as compared to the QT-PCR 

approach, and are fairly standardized and designed to give a specific output. 

 

The ENCODE [19] (Encyclopedia of DNA Elements) project would also lead to providing 

direction in the form of developing many more high throughput approaches for detecting 

locus control regions within the entire human genome, thereby leading to a better 

understanding of the regulatory mechanism of several genes involved in disease 

processes. 
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Appendix - I 
 

Cell Lines and Cell Culture Methods:  
The four cell lines used for the experiment are: 

 

1. IMR-90 Normal Lung Fibroblast [Low Expresser of Kibra]  
[Ref: http://www.atcc.org/common/catalog/wordSearch/results.cfm]  
 

Morphology: fibroblast 

Species: human, Caucasian female 16 fetal weeks;  

Tissue: lung, embryonic 
Cytogenetics: normal human female; diploid; stable 

 

2. T-47D Breast Cancer [High Expresser of Kibra] 
[Ref: http://www.biotech.ist.unige.it/cldb/cl4923.html] 

Morphology: epithelial-like 

Species: human female 54 years old;  

Tissue: breast; Tumor: carcinoma, ductal;  

Derived from: T-47, originally derived from pleural effusion; 

Cytogenetics:  Hypotriploid human cell line. Y chromosome is absent. 

 

3. U-87 MG Glioblastoma [Low Expresser of Kibra] 
[Ref: http://www.biotech.ist.unige.it/cldb/cl5280.html] 
 

Morphology: epithelial 

Species: human, Caucasian female 44 years old;  

Tissue: brain; Tumor: glioblastoma-astrocytoma; 

Tumor stage: grade III 

Cytogenetics: Hypodiploid human cell line.  
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4. MDA-MB-436 Breast Cancer [High Expresser of Kibra] 
[Ref: http://www.atcc.org/ ] 

 

Morphology: pleomorphic with multinucleated component cells 

Species: human, Caucasian female 43 years old 

Source Organ: mammary gland; breast 

Disease: adenocarcinoma 

Derived from metastatic site: pleural effusion 

Cellular Products: tubulin; actin 

Cytogenetics: The line is pleomorphic and most cells react intensely with anti-tubulin 

antibody as demonstrated by indirect immunofluorescence staining. 

 

General Cell Protocols Followed throughout the experiment: 
I. Storage of cells e.g. MDA 436: 

 
1. Remove old media and rinse cells with 15 ml PBS to remove all FBS. 

2. Add 2.7 ml trypsin solution and incubate cells 5-7 minutes (warm trypsin) at 

37°C. 

3. Tap the flask to loosen the cells and once they have loosened, add 15 ml warmed 

media (37°C) to the cell suspension. Collect suspended cells in 15 ml centrifuge 

tube and keep on ice. 

4. Pellet at 100 G for 5 minutes. Remove the supernatent. 

5. Re-suspend cells in media containing 10% DMSO 

6. Label cryogenic vials with the cell line and date. Add 1.5 ml of the DMSO 

containing cell suspension to each vial and seal. 

7. Place vials in -80°C freezer and keep overnight. The following day, after 24 

hours, transfer cells to liquid nitrogen for permanent storage. 

 

Two sets of MDA 436 cells were frozen from two different T-225 flasks. Labeled set 1 

and set 2. Placed in liquid nitrogen tank, rack N. 
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II. Thawing of cell line e.g. IMR-90 (Normal lung fibroblast) 

 

1. Remove cells from liquid nitrogen storage and quickly thaw in 37°C water bath 

by gently agitating vial. 

2. As soon as ice crystals melt, pipette into a culture flask containing pre-warmed 

growth media. 

 

Perform thawing and placed cells in 20 ml growth media. Incubated at 37°C. 

 

III. Passage of cells e.g. MDA 436 

 
1. Wash cells with PBS 2X. Remove PBS from cells each time. 

2. Add 2.7 ml trypsin to flask. Let it sit at 37°C for 5-7 minutes. 

3. Add 5 ml media to cells and transfer 1 ml of cell mixture into new T-75 flask 

containing 20 ml warmed at 37°C media after Trypsinizing cells and allowing 

them to set for 5-7 minutes at 37°C. 

Passing of cells is done when cells reach 90% confluency. 
 
Quantitative PCR – Protocol: 

1. Synthesize cDNA with Invitrogen’s SuperScript III using Oligo dT primers. For 

1000 ng RNA starting material in a 21 uL cDNA synthesis reaction, dilute with 

112.3 uL H2O, which yields [7.5 ng/uL], use 2 uL (15 ng RNA) of this dilution 

for each subsequent qPCR. This will allow analysis of about 22 genes using 2 uL 

per reaction in triplicate. 

 

2. Reverse transcribe the standard curve sample along-side the experimental 

samples. The standard curve should be composed of the RHO samples treated at 

various DNase-I concentrations (10-80 I/U). 
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3. Run samples in 9 replicates with standard curve samples at 30 ng, 3 ng, 0.3 ng, 30 

pg, 3 pg RNA starting material. 

 

4. PCR Thermal cycling conditions:  

Stage 1: 95°C for 10 minutes 

Stage 2: 95°C for 15 seconds and then 60°C for 1 minute (40 cycles) 

Stage 3: Add a Dissociation/ Melting Curve Stage with the following   

              default settings, 95°C for 15 seconds, 60°C for 15 seconds   

              and 95°C for 15 seconds. 
 

QT-PCR Protocol: 
315 uL – SYBR green mix (2X) 

1.9 uL – Forward Primer [100 uM] 

1.9 uL – Reverse Primer [100 uM] 

227.2 uL – Distilled Water               

13 uL – of above mixture to each well 

+ 2 uL – cDNA (15 ng/uL cDNA) 

15 uL  (TOTAL VOLUME of the reaction) 
 

Protocol for DNase-I Digestion and DNA purification [1, 10]: 
DNase-I digestions were performed according to the following protocol: 

E.g. Cell Line: MDA 436 (Breast Cancer) 

 

1. After cultivation cells are spun down, washed twice with 1X FBS and counted. 

2. Add 2.7 ml trypsin solution warmed to 37°C. Let it sit for 5-7 min in incubator at 

37°C 

3. Add 10 ml media (warmed to 37°C) and transfer to 15 ml conical vial. 

2-T-225’s into two 15 ml conical vials (~16 ml volume) 

4. Spin at 500 G for 5 minutes.  

5. Wash cells 2 times with 10 ml PBS. Spin at 500 G for 5 minutes 
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6. Re-suspend in 9.5 ml Buffer A (cold) [Buffer A contains: 15 mM Tris-Cl, pH 8.0, 

15 mM NaCl, 60 mM KCl, 1 mM EDTA, pH 8.0, 0.5 mM EGTA, pH 8.0, 0.5 

mM spermidine, 0.15 mM spermine] 

7. To release nuclei, add 3 ml 2X NP-40 (0.08% in buffer A) drop wise to each tube. 

Incubate on ice for 10 minutes. 

8. Nuclei were centrifuged at 1000 G for 10 minutes. Carefully remove supernatent 

and add 15 ml cold Buffer A. Repeat centrifugation. 

9. Re-suspend both tubes in 1 ml total Buffer A by placing 800 μl buffer A into one 

tube, re-suspending and transferring entire contents into the next tube. 

10. 2X DNase I buffer: 120 mM CaCl2 ; 1.5 NaCl 

   for 50 ml: 6 ml 1 M CaCl2 

        15 ml 5 M NaCl 

        29 ml H2O 

11. Transfer 100 μl of nuclei from step 9 into 9 tubes labeled 0 – 80 (stands for “units 

of DNase I”) 

12. Add 100 μl of 2X DNase I Buffer to each tube. 

13. Add 0, 2, 4, 6, 8, 10, 12, 14 and 16 μl of DNase I to each tube labeled 0 – 80. 

Invert gently to mix. Incubate for 3 minutes at 37°C. 

14. Stop the reaction with 16.6 μl – 5 M EDTA. Flip gently. 

15. Add 12 μl RNase A (10 mg/ml final conc.). Flip gently to mix. Incubate at 37°C 

for 30 minutes. 

16. Add 25 μl Proteinase K (200 μg/ml). Incubate at 55°C, overnight. 

17. Extract with phenol/ chloroform two times. Add 1/10 volume sodium acetate 

(3M). 

18. Add 2.5 volumes (550 μl) 100% Ethanol. Store at -20 °C for 30 minutes. 

19. Spin for 15 minutes, 12000 RPM to precipitate DNA. Wash 2X with 70% Ethanol 

(1 ml). 

20. Let it air dry. Re-suspend in 20 μl TE. 

21. Store at 4 °C. 
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22. Samples were quantified in triplicate at a time for a total of 9 replicates using the 

Applied Biosystems ABI 7900 system. 

 
Appendix - II 

 
Excel worksheet with 386 well PCR plate layout attached with the Report. 

 
 

Appendix – III 
 

Results from MDA-MB-436 cell line for Test Primer A attached with the 
Report 

 
 

Appendix – IV 
 

Known Locus Control Regions to be used as positive controls for the 
microarray approach, alongwith EST related data attached with the Report. 
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